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��Overview

This tutorial provides an introduction to Object Domain through the object-oriented analysis and design of a simple drawing component. For the analysis and design we use the latest Booch methodology and notation.   A majority of this tutorial, however, is applicable to an OMT approach as well.



Some knowledge of object-oriented analysis and design is assumed.  See the references section for more information on related material.





Reference Material

Object-Oriented Analysis and Design with Applications, Second Edition; Grady Booch; Benjamin/Cummings Publishing Company, Inc.; ISBN 0-8053-5340-2

Object-Oriented Modeling and Design; James Rumbaugh, Michael Blaha, William Premerlani, Frederick Eddy, and William Lorensen; Prentice Hall; ISBN0-13-629841-9

Object Domain Help File; Object Domain Systems; 

Tutorial.ood; Object Domain model for this tutorial;

Drawing Component Requirements

The following are the requirements of our simple drawing component:



The component should allow users to draw various shapes on a drawing canvas.  These shapes can be points, lines, rectangles, ellipses, etc.

The tool should be interactive in that the shapes are entered and modified by direct manipulation.  By direct manipulation we mean the user will use the mouse and keyboard to click, drag, type, etc. to directly manipulate the objects on the drawing canvas.  The current active “tool” will interpret these events and provide direct feedback to the user.  For example, to draw a rectangle, the user will press the left mouse button, drag a bounding box, and release.  The tool should give feedback to the user by “rubber-banding” a rectangle in “real-time”.  Upon releasing the mouse button, the rectangle object should be added to the canvas.

The user should  be able to select a shape and change its relevant properties. For example, pen color,  fill color,  line style, etc. 

The application should be easy to port to various windowing systems. e.g. Microsoft Windows, X-Windows, Presentation Manager, etc.

Finally, we should be able to save and retrieve our drawing to and from a document.

Domain Analysis

During the analysis phase, we need to create an object-oriented model of the problem domain.  



This process consists of following phases:



Identifying the major classes

Defining relations between the classes

Defining the operations of the classes

Defining the attributes of the classes

Defining the inheritance relationships



Identifying Major Classes

We can take a first cut at identifying the classes by looking at the nouns in the requirements statement.



The nouns that are candidate classes are: 



shape

canvas

point

line

rectangle

ellipse

property

widowing system

document



Shape is obviously a class.  Point, line, rectangle, and ellipse are instances of shape; we will decide later if we need these classes or not.



Canvas seems to be a class as well.  The canvas contains all the shapes and it represents a window in the windowing system.  Since we want this application to be portable across multiple windowing systems, we will probably inherit from this class to implement the specifics of the windowing system.  This means the canvas will be an abstract class.



Windowing System is a class which represents the actual Windowing system.



Tool is a candidate class and “Rectangle Tool” an instance of this class.

Event is a candidate class also.  An event will be the way the system/hardware will send information to our program.  “Key press”, “Button Hit”, “Mouse Move” are instances of the Event class.  Again we will later decided if we will subclass from event or not.



We also need a class for the editor itself.



Lets now enter these classes in Object Domain.



To add classes in Object Domain,



If you did not already start Object Domain, start it now.

From the File menu, select New. This will open the model’s main window.  This window shows all the diagrams in the model and their hierarchical relationship.  When a new model is created, it automatically creates a top level class diagram.

Double click the line in the main window labeled “Top Level Class Diagram”.   This will open a the class diagram window.

We will now enter the classes identified above into this diagram.  Since we will add multiple classes at once, we want to keep the class tool active. ��Note: The tools of Object Domain work in two modes: locked and unlocked.  In locked mode, Object Domain keeps the selected tool active until another tool is selected.  In unlocked mode, after using a tool, Domain will automatically switch back to the selection tool.  Locked mode is controlled by the Tools pulldown menu or by depressing the toolbar button with a lock icon.��Make sure the keep tool switch is enabled in the tools menu.  Now select the class tool. With this tool you add classes to the diagram by simply clicking at the position where you want to place the class. To name the class, start typing after it is placed.



Your class diagram should resemble the following.�

�

�Drawing Component Classes









At this point, we would normally enter text describing the responsibilities of each class. 



To add responsibilities to a class in Object Domain,

Select the selection tool (the top most tool in the toolbar).

Double click a class icon.

Fill out the “Responsibilities” field.



For the this example, the actual text is unimportant.



Identifying the Relationships

We now add relations between the classes of the model.



To add relations in Object Domain,

With the tools menu, select the relation to add.

Depress the left mouse button inside the class from which you want the relation to start.  Without releasing the mouse button, move the cursor to the receiving class in the relation.  Release the mouse button.

If you want to label the relation, begin typing as soon as the relation is added.



One relation readily apparent is the “has” relation from the Canvas class to the Shape class.  This denotes that the canvas owns or has all shapes.  Appropriately, we will name this relationship  shapes. 



Events are going to be interpreted by Tools, so we will add a relation from the Event class to the Tool class.  We can label this relation interpret.



The Editor owns the Canvas, so we need a has relation from the Editor to the Canvas.

The Canvas is an abstraction of an actual window in a windowing system, so all events will be generated by the canvas.   To represent this, we enter a relation between Canvas and Event labeled  generates.



We still have the Windowing System class remaining.  The Canvas is an abstraction of an actual window in the Windowing System. The Windowing System will also notify the Canvas when some user input event occurs in the window.  Therefore, we need to add a relation between the Windowing System and the Canvas.



The resultant class diagram should now resemble the following.



�

�Classes with Relations



Identifying the Operations

With the class relations defined, we can begin identifying the operations.



We already know that the Tool class needs to interpret events so lets add the operation interpret (event) to the Tool class.



To add operations to a class in Object Domain,

Double click a class.  This will invoke the Class Template dialog. 

In the dialog click the New button in the Operations box.  This will pop up the Operations dialog.

Enter the name of the operation.

To make all Operations of the class visible in the diagram, click the Visible in Diagram radio selection in the operations dialog.

To add parameters, click the New button in the parameters group.  This will pop up an input dialog for entering parameters of an operation.  Repeat for each parameter.



The canvas will receive messages from the windowing system. Messages in which we are interest include: button down, mouse move, and button release.  To abstract from these messages, we add following operations to the Canvas class:



buttonDown (point pos)

buttonRelease (Point pos) 

mouseMove (Point pos).



We also need the following operations to add and delete Shapes from the Canvas.  



addShape(Shape *) 

removeShape(Shape *)

 

We will derive a class from the abstract Canvas class and that will implement the specifics of the windowing system.  It is this class that will call the above methods.  This allows a nice separation from the actual windowing system and our application.  Let us assume we need to first build this component for Microsoft Windows.  Therefore, we can add a new class to our diagram and call this class MSCanvas.



Another class with easily identified operations is the Shape class.  The shape must be able to draw itself on a canvas.  Also, we want the ability to do “hit” testing on a shape.  That is, we want to check if an object contains a point or intersects with a rectangle.  We do not have a rectangle or a point class defined yet, so let’s add these two classes.  These classes are subclasses of  Shape so add an inherit relation from each of these classes to the Shape class.



Now add the following operations to the Shape class:

draw (Canvas *)

bool contains (Point) 

bool intersects (Rectangle) 



Your class diagram should now resemble the following.



��

Class Diagram with Relations and Operations



Adding the attributes

We now add attributes to the classes.



To add attributes to a class in Object Domain,

Double click a class.  This will bring up the Class template dialog.

In the attribute group box, select New.  This will bring up the Attribute dialog.

Fill out the attribute name (e.g. xpos) and its type ( int ).

To make the attribute visible in the diagram, check the Visible in Diagram checkbox.



For the Point class we can add the attributes x pos and y pos using integer types for representation.



The attributes of the Event class are a little more interesting.  An event can represent many things.  Example of events are button press, button release, mouse move, etc.  All of these events have some attributes in common: the event type and position for which the event occurred.  



For our example component, the event type and position are the only attributes we need.  Therefore, add these attributes to the Event class.  We will later assign constants to the event type or use an enumeration.  We could also use inheritance to implement the different events.



We now have the following class diagram.



�



Class Diagram with Operations and Attributes



Validating the model

With the classes and operations identified, we can now validate the model.  For validation, let us assume the following simple scenario:  



The user presses the left button

moves the cursor

releases the mouse button



To represent this scenario, we can build an object diagram or an interaction diagram.  Both model the relationships and interaction of objects.  We will begin by building the object diagram then use a TCL script to generate the interaction diagram.



Object Diagrams

Working with object diagrams is similar to working with the class diagrams.



To add a new object diagram,

Switch to the main window that contains the list of diagrams. You can do this by selecting the Main Window command from the Windows menu.  You can also use the Main Window tool button on the application toolbar.

From the Diagram menu, select New Object Diagram.



To add elements to the diagram, as before, select the appropriate element in diagram toolbar and click the desired position for placement.  Object diagram elements include objects, relations, messages, and return values. We will use only objects, simple messages, and return values in this tutorial.



To model the scenario, we need some instances of the classes we have defined.  Place the following objects on the Diagram:

aCanvas

rectangleTool

aRectangle





To add the objects, 

Add a new object to the diagram and label it with an object name.

Open its template by double clicking;

Using Browse, select the class for which this object is an instance (for example, aRectangleTool is an instance of the Tool class)



The object aCanvas is an instance of the MSCanvas class.  The rectangleTool object is an instance of the Tool class and aRectangle is an instance of Rectangle class.



We also need the following event objects.

buttonDown

mouseMove

buttonUp 



These are all instance of the Event class.



Next we’ll add message relations between the objects.



To add messages to object diagrams,

Select the simple message tool (arrow with no adornments)

Depress the left mouse button inside the class from which the message will originate, and without releasing, move the cursor to the receiving object. Release the mouse button.

If you want to label the message, you can begin typing as soon as the message is added.



Let us now continue validating the scenario as outlined above. We first receive the button down event from the windowing system.  



The responsibility of the canvas is to abstract the system events of a window.  For example, it is responsible for creating the buttonDown event when the user presses the left mouse button.  To reflect this, add a simple message from the object aCanvas to buttonDown.  Will call this operation (message) Create.  We can now enter the return value of the Create method.  Select the Return Value tool from the tool menu (or toolbar) and drag the cursor from the “buttonDown” object to the aCanvas object.



Next, the canvas will send the new event object as a message to the currently active tool.  In this case, the rectangleTool.  Draw a simple message from the object aCanvas to the rectangleTool.   The rectangleTool will interpret this event (we will not show this in this object diagram however).



The canvas object will receive numerous mouse movement events from the system.  In a manner similar to the handling of the buttonDown event, the canvas object will create mouseMove events and send them to the rectangleTool.  Although the canvas object would normally receive many mouse move events, we will model only one.



Finally the canvas object receives the system button up event.  Again the canvas object will create the appropriate buttonUp event and send it to the rectangleTool.  



At this point, the rectangleTool object will create a rectangleShape and add it to the canvas object.  Note that here we see that we are currently unable to add a shape to the the canvas since from the rectangle tool we don’t “know” the canvas object.  We can solve this by adding an attribute to the event class to hold a reference to the canvas object that created the event.   Therefore, switch to the back to the class diagram and add an attribute named canvas to the Event class.  Use the method for adding attributes to classes as outlined previously.



Your final object diagram should resemble the following.



���Object Diagram



Interaction Diagrams

An interaction diagram traces the events of a scenario in a manner similar to an object diagram. 

Instead of building the interaction diagram, we will use a TCL script included with Object Domain to convert the object diagram of the previous section to an interaction diagram.

To convert the object diagram to an interaction diagram,

open the object diagram

Select the Execute script command under the Script menu.

In the entry box, enter a name for the interaction and click OK.



This will generate an interaction diagram.  To view the resultant diagram, go to the main window and double click the diagram with the name you entered in step 3 above.



�

Interaction Diagram



Design

Now that we have validated the model, we can continue into the design phase.  Note that the analysis and design processes are not entirely distinct phases.  They somewhat blend together.  So, although this section is called design, we will continue to analyze the model.



In this phase, we divide the classes into categories providing logical structure to model.   In addition to the logical structure, we want to develop the physical construct of the system.  That is how the design will be cast to source code.  Here we delegate classes to appropriate modules.  



Note that in many designs the categories and the modules of a model will contain equivalent classes.  The Booch methodology, however, does not explicitly impose this restriction.



Finally, from the modules we create,  we will generate source code templates.



Creating categories

Categories are elements of class diagrams that represent a logical partition of classes.  Each category corresponds to a class diagram.  In Object Domain, creating a category automatically creates an associated class diagram.



In this simple component example, we can easily recognize two categories: Tools and Shapes.  A Canvas category will contain the windows and application related classes.



Lets add these categories to a new class diagram.  Switch to the main diagram window and from the Diagrams menu, select New class diagram.



Add the following categories to the class diagram:

Shapes

Tools

Canvas



To add categories to a class diagram, 

From the tools menu (or toolbar) select the category tool.

Place and name the categories. 

Enter the relations between the categories 



The shapes category does not depend on or use any of the other categories but is used by both the Tools and Canvas categories.  Therefore, add a “uses” relation from the Canvas category to both the Shapes and Tools categories.  Also, add a uses relation from the Tools to the Shapes category.



The window classes of the Canvas category make use of the classes embodied in the Tools category so we can enter a uses relation here as well.



Your category diagram should resemble the following.





���Tools Category



Shapes Category

For this example, we will start with a simple shape hierarchy.  We could later extend the hierarchy as we add more shape types.  For example, we could add a “composite shape” class which owns a set of other shapes.  Since this class would inherit from shape itself, we could build a very complex graphics structure using this approach.  Our application only uses the abstract shape class, so all classes which inherit from shape will overwrite the shapes member function.



Open the Shapes diagram associated with Shapes category.  To do this, switch to the main diagram list and double click the Shapes class diagram.



Add a class to represent the shape class.  Note that we already created the Shape class during the analysis.  To make this class view reference the class that currently exists, we need to reference it.  To reference an existing class, open the class template and click the Ref button next to the class name field.  A list of existing classes in the design is shown.  Select the Shape class. The advantage of  “referencing” a class is that any changes made to the class affect all references to that class. 



Add the following classes to the hierarchy: Rectangle, Point, and Line.  Here again the Rectangle and Point classes already exist from the analysis phase, so we need only reference them. 



Add the inherit relations between the subclasses and the abstract Shape class.  The subclasses need to override all the member functions of the Shape class.  Therefore, we need to add each member function to the derived classes.



The resultant diagram should resemble the following.





�



Shapes Category



Tools Category

We will now edit the Tools category.



Open the tools diagram and add the following classes: Tool,  pointTool,  rectangleTool, and lineTool.  

We will also add the Event class to this category.  Although events are created by the canvas, they belong to the tools. 

Add the inherit relations between the Tool class and it’s descendant classes. 

Add the uses relation between each of the Tool class and the Event class.





��

Tools Category

Canvas Category

Create the canvas category:



Open the canvas diagram

Add the classes: Canvas, MSCanvas



We did not go into the design of MSCanvas.  Although we could easily design the appropriate classes and message handling using Object Domain, very good GUI tools exist from compiler and other tool vendors.  We will assume that MSCanvas has been previously designed and implemented and therefore will not model this in our example.



We will also assume this is the case for the Editor class also.  



�

Canvas Category





State Diagrams

To this point we have neglected the internal behavior of the Tool class. We will now look at the states the descendant class rectangleTool (other Tool classes will have similar behavior) goes through by creating a state diagram for it. 



To create a state diagram for the rectangleTool:

Switch to the main diagram list window and select the “New State Diagram” from the Diagram menu.

Enter the states for the rectangleTool : we have a start state, an initialize state, a dragging state, a createRectangle and final state.

Enter the events: buttonDown, mouseMove, and buttonUp  



The state diagram should look similar to the following.







�



State Diagram



Physical Design

Most of our logical modeling is now complete.  We now build the physical (file) structure and generate source templates.



The physical structure is represented by a Module Diagram.  To Create a module diagram, switch to the main window and select the New Module Diagram command from the Diagram menu.



We will make our physical structure reflect our logical structure.  As stated, this is the most common approach but is not required.  



Add three specification icons and three body icons to the diagram.  Name these icons: tools.h, shapes.h, canvas.h, tools.cpp, shapes.cpp and canvas.cpp.



Add the dependencies between the modules: each “cpp” file depends on it’s “h” file. Also add the other dependencies based on the dependencies we have in the categories.  Note that we have a cyclic dependency: Tools uses Canvas and Canvas uses Tools. We could resolve this cycle by using the same module for tools and canvas categories.  We can also resolve this by adding a forward declaration of Canvas in the tools.h file.  We will opt for the second approach.

Now we can assign the classes to the modules.  With the selection tool, double click on each class.  This will popup the module dialog.  Select the classes to add to the module from the left list box and click the “>>” button.  Do this for each module.

Now select all modules.  You can use the Select All command from Edit menu, or with the selection tool, drag a rectangle around all modules.  Also, you can click on each module while holding down the shift key.

We can now generate code for the selected modules.  From the Scripts menu select Execute Script.  This will bring up a File Selection dialog.  Locate the “gencpp.tcl” script in the Object Domain directory and select it.

Files with code templates for the classes in our design are then generated.  View these with any editor.





�



Module Diagram









Note that our tool does not implement all the functionality asked for in the requirements but can be easily added to the current design.
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